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Life Cycle Cost Analysis 

PRACTICAL EXERCISE 
  

  MARS-V 

• Perform and Examine a Total Life Cycle Cost Analysis for 
the MARS-V Computer Parts 
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The MARS V CASA Practical Exercise is a hands-on exercise in which you will be 
developing a CASA data file for MARS V “Shadow” System Parts. The exercise provides a 
general overview of CASA input, output, basic command/movement keys, and steps for 
importing hardware data from a spreadsheet. 
 
Remember to periodically save your data to disk. Like other Windows programs, you are 
working in a temporary workspace and can lose data if your computer crashes.  CASA has 
an “Auto Save” feature which can be enabled.  It is located under the “File” menu.  The 
parameters for this option can be altered. 
 
 The following style is adhered to throughout this exercise:  All “Menu Names” and “Menu 
Commands” are listed in quotes. Dialogue box options are denoted by <>.  The data 
questions are formatted with an underline.   
 
The data within this exercise has been created for the sole purpose of training and is not actual data or based on actual 
data from other systems 

Overview of the Practical Exercise 
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Some questions require more than one value as input.  
The Input Dialogue Box for these types of questions is 
displayed in a grid format, shown at right.  Within this 
dialogue box, you can widen the column width by 
placing the cursor on the separator line, then hold down 
the left mouse button and drag the separator to increase 
or decrease the width.  

Standard Question Input Dialogue 
Box  for Multiple Value Entry      
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Developing a CASA Data File 
When beginning a new CASA data file, there are three steps to follow to avoid possible 

data entry errors later. 
 
1. The first set of questions that MUST be answered are the Beginning Questions.   

You cannot go further until the Beginning Questions are answered. 
 
2. Next , you must “Set Default Year”, which is the year in which most dollars are 

expressed.  This allows easier data entry later. “Set Default Year” is located under 
the “Data” menu on Tool Bar. 

 
3.     Finally, you should run the “System Wizard” to input your production and 

deployment schedule. “System Wizard” is located under the “Data” menu on the 
Tool Bar. 

 
        After completing these steps, you can enter data for the next data group.  We 

recommend you complete each data group in order, so no data question is 
skipped. However, not all data groups/questions within the CASA Data Tree 
Structure need to be answered to execute the model.   
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CASA 

 
             START  THE 

PRACTICAL EXERCISE 
   AT THIS TIME 
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Double-click on the CASA icon on your Desktop to open the program. 
 

Opening Screen 

7 



U.S. Army Materiel Command  |  U.S. Army Materiel Command  |  Logistics Support Activity 

UNCLASSIFIED FOUO 

Cost Analysis Strategy Assessment  Practical Exercise 

Use the mouse cursor to double-click on “Name of CASA Study” and a question 
prompt will appear similar to the one shown below. 
 
 For our practical exercise type in ‘MARS V Computer Parts’ and click <OK> 

Step 1 - Beginning Questions 
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Shown below is an example of a CASA Standard Question Input Dialogue Box 
for Single Value Entry.  To enter a value, type in the answer and press <OK>.  The CASA 
program will automatically display the next question within each data group until you have 
completed the section and then return you to the main screen.  If you want to exit without 
entering or modifying the answer, press <Cancel>. Press the <Comment> button to bring up 
a dialog box for entering comments about the inputted data value (as shown in the picture, 
bottom right).  When done with the comment press <OK> to return to the Question dialog 
box.  Selecting <Help> will display information about the CASA data question. 

Standard Question Input Dialogue Box for 
Single Value Entry 
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Note:   
Once these data    
values are set they  
can only be changed 
by selecting “Change 
Beginning 
Year/Length” on the 
“Data” menu. 

Step 1: Beginning Questions 
The second question is “Starting Year for CASA Study” (i.e. the year in which the first costs 
are incurred).  For our exercise input ‘2012’. 
 
Next, enter the “Length of Study in Months for CASA Study”.    
 
NOTE:  Unit of time for this input is months, not years, so when you do another analysis, if 
you want 20 years, you need to input 240, not 20. 
 
This exercise will cover a 10 year period, so input ‘120’ as the answer.   
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The last three Beginning Questions are “Number of Maintenance Levels for CASA Study” and 
their corresponding names.  The minimum number is 1 and the maximum is 10.  After entering 
the number of levels you will be prompted to enter the name(s) based on the number you 
entered (i.e., if you enter 2 you will be prompted twice for a maintenance level name.) 
   
For our exercise enter ‘2’ for the number of maintenance levels and click <OK>.  Then enter 
the names as  ‘Operations’ and ‘Depot’. 

Step 1: Beginning Questions 

Note: If you want to change 
these inputs later, you must 
use the “Change 
Maintenance Level Wizard” 
under the Data menu 
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Congratulations!  
 
You’ve just configured your MARS V Computer System CASA data file.  You 
will now notice all of the question marks to the left of each question under the 
“Beginning Questions” data group have a check mark over them. This 
signifies these questions have been answered.   
 
Before you enter more data, it is recommended you save your data to disk.  
To do this, select “Save” on the “File” menu or press “Save” on the toolbar.  
CASA will display the standard Windows “Save As” dialogue box.  
 

Completion of Step 1: Beginning 
Questions 
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Saving Your Data to a File 
For this Practical Exercise, save your study to the Desktop. 
 
Select the Desktop directory and type in the filename ‘CASAMARSV’, and click <Save> (default 
filename extension is “.cas”).  Once the data is saved, you will return to the CASA main screen 
and notice the filename you typed in is now displayed in the window title bar. 
 
Again:  Remember to periodically save your data as you answer questions.  Like other Windows 
programs, you are working in a temporary workspace and can lose data if your computer 
crashes.  CASA does have an “Auto Save” feature which can be enabled.  It is located under the 
“File” menu.  Select it and the frequency with which you want to autosave. 
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Prior to entering your cost data, you need to set the default year in which most 
of your costs are expressed.  This will save time and avoid data entry errors 
later.  As each cost is entered, this default value can be over-ridden. 
 
To set the default year, select the “Set Default Year” command under the “Data” 
menu at the top of the screen.  Input the default year as ‘2012’ for our example.  
Once entered, you will notice that if you select the “Data” menu, the “Set 
Default Year menu” will have a check mark on the left side. 
 
NOTE: This is a global variable and if you select this command again and 
change the value CASA will change all “Year Dollars Are Expressed” data 
elements to this new value. 

Step 2:  Set Default Year 
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The "System Wizard" is a labor saving tool that should be ran prior to 
entering your project cost data.  The "System Wizard" stores and provides 
information on the production rate, deployment, and  retirement of the 
systems throughout the life cycle. 
 
To run the “System Wizard", go to “Data” at the top of the main CASA 
window and select “System Wizard”.  This will display the screen as shown 
on the next slide.  

Step 3:  Run System Wizard 
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To start, enter the total number of units to be 
produced during the first year of production (Year 
2012 as listed in the window title bar).  Enter ‘20’ 
in the “Produced” area for our example.  
 
The number produced must be “Deployed”.  You 
can deploy systems produced on a per month 
basis in the same year as produced, or in 
following years.   
 
NOTE:  All systems produced must be deployed 
and retired within the life cycle of the system. 

System Wizard (continued) 
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You deploy the systems by entering the 
number of systems fielded in specific 
month(s).   
 
We need to deploy 20 systems.  We 
will deploy them in Nov/Dec 2012 
(same year as produced). Enter ‘10’ in 
November and ‘10’ in December.   
 
 
Now, we need to retire/remove the 
systems from the field.   Click <Next> 
on the lower right of the window to 
move to the last year of the life-cycle, 
2021.  The year, in the active title 
window, will change as the <Next> 
button is pressed.   

System Wizard (continued) 
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This window displays the last year of the 
life cycle for our project. 
 
At the end of the life cycle, systems must 
be removed (disposed of).  To do this, 
simply enter ‘-2’ systems per month from 
January through October.  Remember, 
you must enter these numbers as a 
negative value for the quantity removed in 
the month(s) you want the systems to be 
disposed. 
 
As you will see, the “Systems to Remove” 
tally (upper left) will decrease until all 
systems have been removed.   When 
done, click <Finish> at the bottom of the 
window. 
 

System Wizard (continued) 
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Program Office Data contains two main categories (Research and Development 
(R&D) and Production). Generally, data for R&D and Production are provided by 
the Acquisition Program Management Office. 
 
As mentioned previously, CASA does not calculate R&D costs.  Users input the 
total amount expended or budgeted by year and CASA throughputs these values. 
 
To start entering data in this section, expand “Program Office Data” and highlight 
“Research and Development Cost”, right-click and select answer (or “Answer” on 
the toolbar or “Data” menu).   

Program Office Data 
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Total RDT&E costs are entered by year.  The year dollars can be changed from the default 
within this screen.  For our example, enter ‘3000000’ in year “2012” .CASA automatically 
enters dollar ($) signs. 

RDT&E Costs 
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You will now break out RDT&E costs in eight 
expense subcategories as shown at left.  This 
information is entered into CASA as a distribution of 
percentages that must sum to 100%.  The data is 
entered as whole numbers (i.e., enter 20% as 20, 
not 0.20).  For our exercise, enter the following: 
 
Research and Development.........20 
Demonstration and Validation.....30 
System/Project Management.........5 
System Test and Evaluation........20 
Training..........................................10 
Data..................................................5 
Software Center............................10 
Other................................................0 

RDT&E Spread 
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Production Cost Data pertains to data associated 
with the production and acquisition of the system.   
 
If the “System Wizard” has been completed then 
the questions  “System Production Data Per Year” 
and “System Deployment Data Per Year” are 
displayed with a green check mark.  This indicates 
answers have already been supplied for these 
subcategories. 
 

Production Cost Data 
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Double click “General Information” under “Production Cost Data” to answer the following questions: 
Year in which dollars are expressed – This is answered when we set the default year.   
Cost Adjustment Factor - This factor is multiplied by the unit cost of each system and hardware item to derive 
new costs (i.e., similar to a scaling factor).  If costs for basic logistics data will be used, then this input should be 
‘1.0’ (enter ‘1.0’ for our exercise).  
 
MTBF Adjustment Factor - For each item, the MTBF is divided by this factor.  This value must be greater than 
0.0 or a run time error will occur. The default value is ‘1.0’ and will be the value for our practical exercise.  
 
Operating Hours Per Month Per System – Enter the predicted average hours per month the system will be 
operating.  This will directly influence the number of maintenance actions required each month.  Enter ‘320’ for 
the practical exercise. 
 
Operator Required Portion - The percentage of time per system that an operator is chargeable to system 
operation costs.  For each operator, sum  the total together (two operators at 100% each should be ‘200’).  For 
our exercise, enter ‘100’ to signify that one full time operator is needed. 
System Operator Labor Rate – The average hourly salary for an operator, enter ‘20’.  

Production Cost Data: 
General Information 
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Support Equipment and Spares Factor - The estimated decimal fraction of available support 
equipment hours per month (Enter ‘0.8’).  This means that the support equipment will be 
available 80% of the time to perform maintenance functions. 
 
Portion of Repair Time for RTOK – The percentage of time spent re-testing at the 
maintenance facility only to determine that the unit is operational.  Enter ‘0.05’ for our 
exercise. 
 
Consumables Factor - The portion of repair parts and materials cost that is expected to be 
required for consumables, such as alcohol, cleaners, swabs, solders, etc. (expressed as a 
decimal fraction).  Enter ‘0.1’ in our sample file. 
 
Inflation Rate – Accepted inflation rate predictions are published by the Federal Government.  
Enter ‘0’ for 2012 and ‘2.2’ for all other years. 
 
Interest Rate/Discount Rate - Accepted discount rates are published by the Federal 
Government.  Enter ‘0’ for the year 2012 and ‘2’ for all other years.  This variable also serves 
as the interest rate when calculating “Net Present Value” in the Net Present Value Report.  

Production Cost Data: 
General Information (Continued) 
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Yearly MTBF Adjustment Factor - These factors adjusts the MTBF of each 
hardware item (except scheduled maintenance items) in order to obtain different 
MTBF values for each year.  These factors are already entered and set to a default 
value of ‘1’ for all years.  Note:  Each of these values must be greater than “0.0”. 
 
Previous Quantity of Systems Built – This input helps to characterize the maturity 
of the production facility.  The total number of units previously built should be 
entered.  For our sample file, enter ‘5000’. 
 
Base System Unit Cost – If no previous units have been produced, then this input 
should contain the average unit cost of the system.  If previous units have been 
produced, then this should contain the original price of the first unit.  Enter ‘7500’ 
for the “Base System Unit Cost” in the sample file. 
 
Installation Cost per System – This prompt is for the total cost to install each unit.  
Enter ‘1200’ for the “Installation Cost” per System. 
 
 

Production Cost Data: 
General Information (Continued) 
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As shown, this data group has a big aqua colored plus sign.  This means you 
can add/delete items to this category.   Once the item has been entered, you can 
delete it by right-clicking and selecting delete.  This data category pertains to 
items used during the production process only.  Support/test equipment 
associated with repair are not entered here (enter in the O&S data group).  An 
example of a Production Tooling and Test Equipment item might be a multimeter 
to be used for quality control. 

Production Tooling and 
Test Equipment 
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To add an item, highlight “Production Tooling and Test 
Equipment Data”, right-click, and select “Add” from the 
pop-up menu.  For our sample file, add one piece of test 
equipment entitled ‘Multimeter’ and press <OK>.  The 
main screen will be displayed and you will notice that the 
item was added to the data tree under Production Tooling 
and Test Equipment. You will also notice there are two 
more questions listed under the Multimeter. You now 
have to input these answers which pertain to the cost of 
the Multimeter.  As pieces of production test equipment 
are added, the data tree will expand and prompt you for 
specific cost details. 
For our sample file, enter ‘2012’as the year in which the 
cost will be incurred and ‘75’ for the cost of the 
Multimeter. 

Production Tooling and Test Equipment 
(continued) 
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Production Cost Data: 
Production Start-Up Cost 

Year of Production Start-Up – The year in which the production start-up cost 
is incurred (‘2012’). 
 
Production Start-Up Cost - Start-up costs should include the cost of 
activities identified as necessary to initiate a production program.  Items 
such as drawing updates, factory training, qualification tests, initial set-up of 
production flow, demonstrations, etc., should be included as applicable. 
 
For the sample file, enter the start-up year as ‘2012’, with a cost of ‘275000’. 
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Production Cost Data: 
Shipping and Storage Containers 

Year of Shipping Container Cost – The year in which the shipping 
containers will be purchased, enter ‘2012’.   
 
Number of Shipping Containers – The number to be purchased, 
enter a quantity of ‘20’. 
 
Cost per Shipping Container – The average cost per unit, enter 
‘1000’. 
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Production Cost Data: 
Pre-Production Engineering Cost 

 
 
 
 
“Pre-Production Engineering Cost” is a data group in which items can be 
added/deleted.  As with the “Production Tooling and Test Equipment” data 
group, as you add items, the CASA Data Tree Structure will expand and 
prompt you to answer questions pertaining to specific costs of the item 
added (an example is shown above).  This cost  is non-recurring and should 
include all items needed to fully characterize this data cost group 
 

For our Exercise, we will not enter pre-production engineering costs. 
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Pre-Production  
Refurbishment Data 

Pre-Production Refurbishment Data addresses the costs incurred to refurbish 
or upgrade pre-production units for re-issue.  One example of this could be a 
unit produced for acceptance testing, which has a configuration slightly 
different than the final production design.  The refurbishment cost updates the 
unit to the production design specification.  
 
For our sample file, enter ‘2012’ for “Year”, enter ‘2’ for “Number of Pre-
Production Units to be Refurbished”, and enter a “Cost” of ‘2500’. 
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Production Learning Curve Data 

Quantity Slope:  When the total quantity built doubles, the system unit cost is multiplied by Quantity 
Slope.  For example, if Quantity Slope equals 0.90 (and Rate Slope equals 1.0) and the cost of the 
100th system is 1000, then the cost of the 200th system would be 900 and the cost of the 400th system 
would be 810. For our sample file, you will enter ‘0.98’ for each year of the life cycle. 
 
Rate Slope:  When the quantity built within a year doubles, the system unit cost is multiplied by Rate 
Slope. For example, if Rate Slope equals 0.90  (and Quantity Slope equals 1.0) and the system unit 
cost is 1000 when 100 systems are built in a year, then if 200 systems are built in a year, the system 
cost will be 900. It is recommended that your Rate Slope values be the same for each year.  Changing 
the Rate Slope values between years can have a dramatic effect on system cost. For our sample file, 
you will enter ‘1.0’ for each year of the life cycle. 
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System Reliability Growth Data 

The “System Reliability Growth Data” group has four options: None, Annual, Duane, or 
Item.  None means no reliability growth is considered.  Annual growth is based on an 
annual factor for the system.  The Duane method uses the Duane growth factor for the 
system.  Item means the Duane growth factor for the item will be used.  For the None 
option, the MTBF values from the data file will be used for each year.  For the Annual and 
Duane options, the reliability growth is calculated for the system and each item within the 
system follows the same growth curve.  For the  Item option, reliability growth is calculated 
for each item.   
 
For our sample file, select ‘None’. This will place an “X” over each input prompt that is no 
longer applicable (as shown in the figure at the top right).  This example is seen on your 
Data Item Tree on CASA program. 
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The hardware data for your system can be entered manually from the data tree, or 
by importing data from an Excel file. 
For this practical exercise, we will import data from an Excel file.  Before importing, 
the “MTBF for System Hardware Level 0” must be changed to represent the overall 
system’s MTBF.  This is done by changing MTBF for Level 0 from ‘9999999.0000’ 
to ‘100000’.   Under “System Data” double-click “Mean Time  Between Failures 
(hrs) for Level 0” to bring up the question dialogue box – enter ‘100000’ and click 
<OK>. 

System Data 
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System Data 
Import from Excel File 

Now we will import hardware data from an Excel file.  Two template Excel files are 
distributed with CASA and located on your desktop. 

These files are called “Sample hardware.xls” and “TowExport.xls”.   

Highlight “System Data, System Hardware Data Level 0”, indicated by a blue plus 
sign, as shown below.  The blue plus means you can “Add” or import items. 
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Importing Hardware Data from Excel 

The next series of slides will lead you through the process of importing hardware 
data from an Excel file.  You will import two files, therefore this process will be done 
twice, once for the Sample Hardware.xls and again for the TowExport.xls file. 
To start, right-click on “System Hardware Data Level 0”.  Select “Add from 
Spreadsheet.” The file chooser dialogue box will appear.  Select the Sample 
Hardware Excel file from your Desktop.  Click <Open> to open the file. 
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Importing Hardware Data from Excel 

      In the Data Source field select “CASA”. In the Column Order field select “Default”. In the 
Spreadsheet Data field, select the first item in the Excel file (row 4) by clicking on the 
“4”, hold the left mouse button and pull down to the last item.   Click the “Import 
Spreadsheet” button once.   

     CASA will return you to the main screen and the hardware data you selected is added to 
your data file.   
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Importing Hardware Data from Excel 

Now we will import the TowExport.xls file. 
 
To start, right-click on “System Hardware Data Level 0”.  Select “Add from 
Spreadsheet.” The file chooser dialogue box will appear.  Select theTowExport Excel 
file from your Desktop.  Click <Open> to open the file. 
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Importing Hardware Data from Excel 

In the Data Source field select “COMPASS”. In the Column Order field select      
“Default”. This COMPASS file is missing an MTBF which CASA requires. In the Generate Missing Data field select 
the “MTBF” check box. WBS Level 1= ‘12000’ and WBS Level 2=‘13000’. The Generate Missing Data function 
allows you to correct the spreadsheet to include the missing MTBF. In the Spreadsheet Data field, select the first 
item in the Excel file (row 2) by clicking on the “2”, hold the left  mouse button and pull down to the last item.   
Click the “Import Spreadsheet” button once.  
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Once you return to the main screen, you will see 
the hardware items you imported by  expanding 
the plus sign in the square next to “System 
Hardware Data – Level 0”.  
 
Now you can highlight one of the Hardware Data 
items you imported, double click and expand it.  
You can see the data imported from the 
spreadsheet for that particular item. 
 
The next item in this section is “System Hardware 
Data – Default Values”.  This area is not necessary 
for our exercise.  These questions should only be 
answered for a Risk Analysis.  Continue to 
“Operation and Support Data”. 

Importing Hardware Data from Excel 
(Continued) 
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Now we move on to “Operation and Support Data”.  
Highlight this area on the Data Tree on the left side of the 
CASA main screen.  
 
“Operation and Support Data” has two subgroups:  
“Maintenance Data” and “Acquisition Logistics Data” 
 
“Maintenance Data” corresponds to data about the unique 
maintenance level(s) you previously defined in the 
“Beginning Questions” data group.  
 
“Acquisition Logistics Data” deals with support items 
necessary to perform corrective maintenance. As the 
CASA tree shows, this data group includes, but is not 
limited to:  Support Equipment, Transportation, Technical 
Documentation, Training/Training Devices, Facilities, Item 
Management, and Software Development/Maintenance. 

Operation & Support Data 
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Operation & Support Data Input 

CASA Question Operations Depot 

Number of Operating Systems Supported 1 30 

Maintenance Labor Rate ($/hr) 45.00 75.00 

Software Personnel Labor Rate ($/hr) 55.00 95.00 

Available Support Equipment Hours per 
Month at 80 80 

Support Equipment Utilization Factor at 0.8 0.8 

Support Equipment Spares Cost Portion at 1.0 1.0 

Spares Confidence Level at 0.95 0.95 

Earned Hour Ratio at 1.0 1.0 

System Repair Elapsed Time at 3.0 7.0 

Enter the following O&S Maintenance Data for our example file 
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￭ Number of Operating Systems Supported - This variable indicates the maximum number 
of systems supported at a given type of maintenance facility. This ultimately will 
determine the number of facilities needed, and the cost to equip and operate each 
facility will add to the life cycle cost. 

￭ Maintenance Labor Rate ($/hr) - This represents the average labor rate charged for 
repair work at the respective maintenance facility. 

￭ Software Personnel Labor Rate($/hr) - This represents the average labor rate charged 
for software work performed at the respective maintenance facility. 

￭ Available Support Equipment Hours per Month - The number of available hours per 
month for support equipment at this maintenance level.  This is used to determine, 
based on maintenance demand, how many units of support equipment to buy and 
maintain.  This can never be 0. If there is no activity at a particular level, enter a 1.  

￭ Support Equipment Utilization Factor - The fraction of Available Support Equipment 
Hours per Month that the support equipment is actually available.  This can never be 0, if 
there is no activity at a particular level, enter a 1.  This is used in support equipment 
loading to determine the support equipment requirements. 

Operation & Support Data: 
Maintenance Data Definitions 

Below are some data item definitions from the O & S data entry 
section on the previous page:  
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Operation & Support Data: 
Maintenance Data Definitions 

￭ Support Equipment Spares Cost Portion - The initial cost of support equipment spare 
modules, piece parts, and material for repair of support equipment at this 
maintenance level, expressed as a decimal fraction of support equipment acquisition 
cost. 

￭ Spares Confidence Level - The spares no-stockout confidence level at this 
maintenance level, expressed as a decimal fraction.  This is the probability of meeting 
all spares demands within the turnaround time of an item.  This is used in initial 
acquisition of hardware spares. 

￭ Earned Hour Ratio - The earned hour ratio at this maintenance level.  This factor 
multiplies input Mean Time to Repair and Support Equipment Hours Required at Each 
Maintenance Level to obtain actual elapsed times.  This is used in system and 
support equipment repair costs, and training cost.  This provides a method for 
adjusting the Mean Time to Repair to account for logistics downtime or other factors. 

￭ System Repair Elapsed Time - The mean elapsed time (in hours) to remove and 
replace an LRU from a system (used only in Ao equations). This time includes 
transportation time. 
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Highlight “Acquisition Logistics Data” on the Data Tree 
and expand by clicking the plus sign. 
 
Acquisition Logistics Data deals with the support items 
necessary to perform corrective maintenance.  As the 
CASA tree shows, this data group includes, but is not 
limited to:  Support Equipment, Transportation, Technical 
Documentation, Training/Training Devices, Facilities, Item 
Management, and Software Development/Maintenance.   
 

Operation & Support Data: 
Acquisition Logistics Data 
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Support Equipment Maintenance Data:  Add a piece of support equipment by highlighting 
“Support Equipment Maintenance Data” right click and select “Add.”  The name of the item 
is “Multimeter.”  Once you enter the name press <OK>, which will return you to the main 
screen. 
 
Answer the three questions pertaining to data on the Multimeter.   The 3 questions are:  
“Unit Cost”, “Annual Maintenance Factor”, and “Support Equipment Hours Required for 
Each Maintenance Level”.   
 
For our practical exercise enter the following values:  “Unit Cost” = ‘500’; “Annual Maintenance Factor” = 
‘0.1’; “Support Equipment Hours Required for Each Maintenance Level” = enter as ‘0.25’ hours for the 
‘Power Supply’ at each maintenance level. 

Operation & Support Data: 
Acquisition Logistics Data 
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Transportation Cost: 
 
This area accounts for the cost of shipping items between maintenance 
levels.  In CASA, transportation costs are based on weight and cost per 
pound.   
 
Enter ‘3’ for Operations to Depot . Assume ‘0’ for Depot to Factory cost.  
Enter  ‘25’ for Packaging and Paperwork Cost. 

Operation & Support Data: 
Acquisition Logistics Data 
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Now add a reusable container by highlighting “Reuseable Container 
Data” on the Data Tree. 
Right click the mouse on the highlighted area, and select “Add.” 
Type in “CPU Shipping Box” 
Select <OK> 
Answer the questions pertaining to the item added.   
Enter ‘2012’ as the year and ‘300’ for the cost of the CPU Shipping 
Box.  

Operation & Support Data: 
Acquisition Logistics Data 
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Now add an “Installation Manual” under “Initial Technical Documentation”. 
 Highlight “Initial Technical Documentation”, then right click. 
 Click “Add” and type in “Installation Manual”. 
 Answer the additional questions that follow. 
 “Year Cost Incurred” = ‘2012’ 
 “Total Number of Pages” = ‘100’ pages long. 
 “Average Cost per Page to Develop” = ‘500’ per page. 
 “Average Cost per Page to Publish” = ‘0.60’ per page. 
 “Total Number of Copies” = ‘50’ Install manuals.  

Operation & Support Data: 
Acquisition Logistics Data 
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Recurring Technical Documentation: 
 
This data group pertains to each level of maintenance.  However, data 
may not always be required for all levels.   
 
For this Practical Exercise, enter the following at each maintenance level: 
> ‘2’ revised pages per year 
> cost of ‘1000’ per page. 

Operation & Support Data: 
Acquisition Logistics Data 
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Under “Initial Training Transportation Cost”, answer “Per Diem” and 
“Round Trip” cost as stated below: 
 
Input a “Per Diem” estimate of ‘150’ for each trainee and a “Round-
Trip” cost of ‘900’.  

Operation & Support Data: 
Acquisition Logistics Data 
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Also under this data subgroup, you can add courses for “Initial Training”. Right 
click on “Initial Training Course Cost” and add a “System Maintainer Course”.   
Enter the following data pertaining to this course: 
“Year” = ‘2012’; “Class Hours” = ‘16’ ; “Development Cost” = ‘250’; 
“Trainee Labor Rate” = ‘75’ ; “Number of Trainees” = ‘30’; “Number of Days” = 
‘2’; “Number of Instructors” = ‘2’; and “Instructor Labor Rate” = ‘95’. 

Operation & Support Data: 
Acquisition Logistics Data 

52 



U.S. Army Materiel Command  |  U.S. Army Materiel Command  |  Logistics Support Activity 

UNCLASSIFIED FOUO 

Cost Analysis Strategy Assessment  Practical Exercise 

Under “Recurring Training” enter the following values  for both 
maintenance levels: 
 
“Recurring Training” will be entered as ‘16’ hours 
  
“Development Cost per Hour” of ‘250’. 
 
“Annual Turnover Rate is ‘0.33’. 
 

Operation & Support Data: 
Acquisition Logistics Data 
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We will now add a “Repair Trainer Unit” under “Training Devices”.  
 
Highlight “Training Devices” and right click. 
 
Click “Add” and answer the questions for “Repair Trainer Unit”. 
 
The unit will be procured in the year ‘2012’ and a quantity of ‘3’ training 
units will be purchased at a unit cost of ‘20000’. 

Operation & Support Data: 
Acquisition Logistics Data 
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A government owned “Production Facility” will be required under “New 
Facilities”.  Highlight “New Facilities”, right click, and click “Add”.  Type 
‘Production Facility’ and answer the following questions. 
 
“Year Cost Incurred for Production Facility” = ‘2012’ 
“Number of Square Feet for Production Facility” = ‘5000’ 
“Cost per Square Foot for Production Facility” = ‘200’   

Operation & Support Data: 
Acquisition Logistics Data 
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In this example, there is no cost for “Recurring Facilities” at the 
Operations level.   Therefore, input these values as ‘0’. 
 
The Depot Maintenance Level requires ‘400’ square feet of space at 
an annual cost of ‘80’ per square foot. 
 

Operation & Support Data: 
Acquisition Logistics Data 
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New parts may be introduced into the project under “Initial Item 
Management”. 
 
For this exercise, input the following:  
 
“Year Cost Incurred” = ‘2012’ 
“Number of New Part Types” = ‘10’ 
“Initial Cataloging” = ‘1000’ 

Operation & Support Data: 
Acquisition Logistics Data 
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For “Recurring Item Management”, and the “Operations” level input: 
 
“Quantity of New Part Types for Operations” = ‘1’ 
“Recurring Cataloging Cost  at Operations” = ‘10’  
“Quantity of Part Type at each Location for Operations” = ‘1’ 
“Recurring Bin Cost at Operations” =  ‘1000’ 

 
REPEAT these values at the Depot levels. 

Operation & Support Data: 
Acquisition Logistics Data 
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Other Input Cost Data  
Contractor Services 

Input Contractor Technical 
Representative costs for 2012  in the 
Operations Level only. 
 
Expand “Contractor Services”, 
“Operations” Level, “2012”, and answer 
the two questions. 
 
Use ‘1’ man-month and “Cost per Man-
Month” = ‘10000’ 

“Other Input Cost Data” covers 
contracted services, engineering 
changes, other anticipated 
miscellaneous costs, warranty costs and 
cost risks. 
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Enter Other Input Data: 
System Cost Risk Analysis Data 

The purpose of the Risk Analysis is to examine the likelihood that the 
life cycle cost will fall within a specified range relative to the predicted 
point estimate. Uncertainty in unit cost, MTBF, and MTTR can be 
modeled using a constant, normal, triangular or uniform distribution. 
 
For our exercise we will leave this value as a ‘Constant Distribution’ 
with ‘1’ used as the “Value for Constant Distribution”.    
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Create Reports 
The CASA Reports are designed to 
support a specific need of the analyst. 
The reports summarize the LCC 
calculation results, characterize the 
validity of assumptions, identify cost 
drivers, and perform comparisons with 
other CASA files.  
 
Go to “Reports” on the Menu Bar and 
click “Complete Life Cycle Cost Data” 
to run this report. 
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Output Reports:  
Complete Life Cycle Cost 

The complete Life Cycle Cost 
Data Report is a summary 
report of all costs.  Costs are 
shown in the RDT&E Phase, 
the Acquisition Phase and the 
Operation and Support Phase. 
The Total LCC tab provides 
costs for all phases.  Further 
detail is shown by clicking on 
the individual tabs at the 
bottom of the spreadsheet.   
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Output Reports: 
Constant Dollar Yearly Table 

The Constant Dollar Yearly 
Cost Table Report 
provides the same cost 
categories as the 
Complete Life Cycle Cost 
Report, but it breaks down 
the cost by year.  The data 
is shown in both tabular 
and graphical formats.  
The graphical format can 
be viewed by clicking on 
the “Chart” tab at top of the 
window. 
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There are 3 options within this 
report. The “Confidence Level 
Method” allows users to define 
the acceptable spares 
confidence level at the lowest 
level of maintenance.   
 
The “Optimization Method” 
determines the best spares 
inventory based on spares 
budget. 
 
The “Target Value Method” 
optimizes spares based on Ao 
target.  Click on the 
appropriate tab at the top to 
select which method to view.    

Output Reports: 
Operational Availability Report 
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The Sensitivity Report provides 
a convenient tool to assess the 
impact of data estimates and 
assumptions. 
 
Simply select the categories to 
check and enter four sensitivity 
parameters that are scaling 
factors based on a percentage 
of the original value. 
 
The report generated will show 
how the LCC for your project 
would change if your inputs were 
updated at a later time.  

Output Reports: Sensitivity Analysis 

65 



U.S. Army Materiel Command  |  U.S. Army Materiel Command  |  Logistics Support Activity 

UNCLASSIFIED FOUO 

Cost Analysis Strategy Assessment  Practical Exercise 

The output values are 
displayed in both table and 
graphical formats.  The 
results for each varied 
parameter are displayed on 
separate tabs. 

Output Reports: Sensitivity Analysis 
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The Maintenance Actions  
per Location report provides  
the number of maintenance  
actions at the location of the 
primary repair level.  

Output Reports: 
Maintenance Actions Per Location 
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Survey 

   After finishing this practical exercise in class, please go to the 
following address and fill out our training survey: 

 
 
    https://www.logsa.army.mil/lec/forms/training/survey.cfm 
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Life Cycle Cost Analysis 

Contact the LEC staff through our SmartDesk at: 
 

                         (256) 955-9847 
                          DSN 645-9847 
   

      Or with email at: 
 

Email: logsa.powerlog.help@conus.army.mil 
Web: https://www.logsa.army.mil/lec/casa/ 

 
 

 

LEC SmartDesk 
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